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The following symbols guide you through this module: 

 

 

 Information 

 

 

 Programming 

 

 

 Sample Task 

 

 

 Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



           Automation and Drives - SCE 

   

 

T I A  Training Document Page 4 of 32 Module 
E06 
Status: 02/2008        PROFINET/PROFIBUS DP with CPU 315F-2 PN/DP/IE/PB Link and DP Slave 
ET200S 

Preface                                     Notes                                     StartUp 

 

1. INTRODUCTION 

 

Regarding its content, Module E06 is part of the training unit 'IT Communication with SIMATIC S7’. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Training Objective: 

 

In Module E06, the reader learns how PROFIBUS DP components can be incorporated at 

PROFINET. In the process, he also learns how the CPU 315F-2 PN/DP with the IE/PB link as 

gateway and the ET200S as DP slave is started up. The E06 Module demonstrates what to do in 

principle, providing a brief example.  

 

Preconditions: 

 

To successfully work through this module, the following knowledge is assumed: 

 

• Experience in handling Windows 

• Fundamentals of PLC programming with STEP 7 (for example, Module A3  'Startup’  

PLC programming with STEP 7) 

• Fundamentals of network technology (for example, Appendix V – Basics of Network    

 Technology) 

Fundamentals of 
STEP 7 Programming  
2 to 3 days      Modules A 

Industrial  
Fieldbus Systems 

2 to 3 days   Modules D 

Additional Functions of  
STEP7 Programming 
2 to 3 days    Modules B 

Process 
Visualization 

2 to 3 days   Modules  F 

Programming 
Languages 

2 to 3 days   Modules C 

IT Communication 
with SIMATIC S7 

2 to 3 days Modules E 

Plant Simulation 

with SIMIT SCE 

1 to 2 days   Modules G 

Frequency Converter 

at SIMATIC S7 

2 to 3 days   Modules H 
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Hardware and Software required 

 

1 PC, operating system Windows 2000 Professional starting with SP4/XP Professional starting 

 with SP1/Server 2003 with 600MHz and 512RAM, free disk storage approx. 650 to 900 MB, MS 

 Internet Explorer 6.0 and network card 

2 Software STEP7 V 5.4 

3 PLC SIMATIC S7-300 with CPU 315F-2 PN/DP 

 Sample configuration: 

 - Power pack: PS 307 2A 

 - CPU: CPU 315F-2 PN/DP 

4 PN/DP Link 

5 Distributed IO ET200S for PROFINET with 2 digital inputs and 4 digital outputs 

 Sample configuration: 

 - Interface module: IM 151-1 HF 

 - Power module: PM-E DC 24V…48V/AC24V…230V 

 - Electronic module: 2DI Standard DC 24V 

 - Electronic module: 4DO Standard DC 24V/0.5A 

6 Ethernet connection between PC, CPU 315F-2 PN/DP and IE/PB Link 

7 PROFIBUS connection between IE/PB Link and ET200S  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5 ET 200S 

 

1 PC 

 

2 STEP 7 

 

3 SIMATIC S7-300 
with CPU 315F-2 

PN/DP 7 PROFIBUS Line 
6 Ethernet Network 

 

4 IE/PB Link 
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2. NOTES ON USING THE CPU 315F-2 PN/DP 

 

The CPU 315F-2 PN/DP is a CPU that is shipped with 2 integrated interfaces. 

- The first interface is a combined MPI/PROFIBUS-DP interface that can be used at the 

PROFIBUS DP as master or slave for connecting distributed IO/field devices with very fast 

 response timing. 

Moreover, the CPU can be programmed here by means of MPI or PROFIBUS DP  

- The second interface is an integrated PROFINET interface.  

It allows for using the CPU as PROFINET IO controller to operate distributed IO on  

 PROFINET. The CPU can also be programmed by using this interface!  

- In addition, both interfaces can be used for fail-safe IO devices.  

 
Notes:   

- In Module E06, the CPU 315F-2 PN/DP is used at the PROFINET as IO controller. 

- A MMC is needed to operate this CPU! 

- The addresses of the input and output modules can be parameterized at this CPU. 

 

3. NOTES ON USING THE PN/DP LINK 

 

As an independent component, the IE/PB Link is the seamless transition between Industrial Ethernet 
and PROFIBUS. 

 

PROFInet makes communication relationships of the PROFIBUS devices among each other as well 
as to Ethernet devices possible. In this case, the IE/PB Link supports the connection of simple DP 
slaves as well as the connection of  PROFIBUS devices with loadable functionality in the form of a 
program; for example, the ET 200S with CPU. 

  
In addition, the IE/PB Link offers the following functions:  

- S7 routing: 

Allows for network-overreaching PG/OP communication. That means, all S7 stations can be 
programmed remotely at the Industrial Ethernet or at the PROFIBUS from the PG. Visual display data 
of S7 stations on the PROFIBUS can be accessed by the Industrial Ethernet from operator interface 
stations. <<? sentence not clear in original>> 

- Data record routing (PROFIBUS DP): 

This makes it possible, for example, to parameterize and diagnose  -with SIMATIC PDM (on the PC)- 
a PROFIBUS field device at the Industrial Ethernet by means of the IE/PB Link. 
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4. NOTES ON USING THE ET200S WITH IM 151-1 HF 

 

The SIMATIC ET200S is a distributed IO device set up in a fine-modular configuration. It can be 

operated with different interface modules: 

IM 151-1 BASIC, IM 151-1 STANDARD and IM 151-1 FO STANDARD for connecting a maximum of 
63 IO modules (all types, except for PROFIsafe) to the PROFIBUS DP;  as an alternative, bus 
connection with RS 485 Sub-D connector, or by means of an integrated fiber optic connection. 

IM 151-1 HIGH FEATURE for connecting a maximum of  63 IO modules (all types, including clocked 
mode for PROFIsafe) to the PROFIBUS DP; bus connection with RS485 Sub-D connector 

IM 151-3 PN for connecting a maximum of 63 IO modules (all types, including clocked mode for 
PROFIsafe) to PROFINET IO controllers; bus connection by means of RJ45 connector 

IM 151-3 PN HF (HIGH FEATURE) for connecting a maximum of  63 IO modules (all types including 
clocked mode for PROFIsafe) to PROFINET IO controllers; bus connection by means of 2x RJ45 
connector 

IM 151-7/F-CPU, IM 151-7/CPU or IM 151-7/CPU FO for connecting a maximum of 63 IO modules 
(all types; PROFIsafe only with IM151-7/F-CPU) to the PROFIBUS DP; as an alternative, bus 
connection with RS 485 Sub-D connector or by means of integrated fiber optic connection;  with 
integrated CPU 314 of the SIMATIC S7-300 for preprocessing process data. 

The following IO modules can be used: 

Power modules for individually grouping load and encoder supply voltages, and their monitoring 

Digital electronic modules for connecting digital sensors and actuators  

Analog electronic modules for connecting analog sensors and actuators  

Sensor module for connecting IQ Sense sensors 

Technology modules  Electronic modules with integrated technological functions; such as counting, 
positioning, data exchange, etc.. 

Frequency converter and motor starter modules 

For training purposes, we now have an integrated system that can be used for teaching a number of 
technologies. 

 
Notes:   

- In Module E06, the interface module IM151-1 HF(HIGH FEATURE) is used as  

 PROFIBUS DP slave. 

- The PROFIBUS address is set binary-encoded at 8 switches at the interface module IM151-1 

 HF. The lowest switch has to be set to OFF. A number is assigned to each of the other 

 switches. These numbers add up to the PROFIBUS station address. 

A modified setting of the PROFIBUS address will be used only after voltage recovery.  

 Consequently, the interface module IM151-1HF has to be switched off and then switched on 

 again. 
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5. STARTING UP THE PROFINET/PROFIBUS DP WITH IE/PB Link  

Below, the following is described: the startup of a PROFINET network with the CPU 315F-2 PN/DP 

as IO controller, the IE/PB Link as the gateway PROFINET/PROFIBUS DP, and the ET200S as 

PROFIBUS DP slave. 

For testing the configuration, a program is written where a display lamp P1 is activated when two 

buttons S0 and S1 are operated at the same time. 

 

Assignment list: 

I0.0  S0  Button selection 1 

I0.1  S1  Button selection 2 

O0.0 P1  Display lamp 

 

1.  The central tool in STEP7 is the 'SIMATIC Manager’. It is called here with a double click. (→ 

SIMATIC Manager) 

 

2.  STEP 7 programs are managed in projects. We are now setting up such a project (→ File → New) 
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3. Now, we assign the ’Name’ ’ET200S_IE_PB_LINK’ to the project ( → ET200S_IE_PB_LINK → 

OK) 

 

 
 

4. Next, highlight your project and insert a ’PROFIBUS Subnet’ (→ ET200S_IE_PB_LINK → Insert 

→ Subnet → PROFIBUS).  
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5. Highlight your project again and insert an ’Industrial Ethernet Subnet’ (→ 

ET200S_IE_PB_LINK → Insert → Subnet → Industrial Ethernet). 

 
 

6. Next we insert a ’SIMATIC 300 Station’. To do this, the project has to be highlighted (→ 

ET200S_IE_PB_LINK → Insert → Station → SIMATIC 300 Station) 
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7.  Open the configuration tool for the 'Hardware’ with a double click. (→ Hardware) 
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8.  Open the hardware catalog by clicking on the symbol ' ’. (→ ) 

In this catalog, all racks, modules and interface modules for configuring your HW setup are 

provided, arranged in he following directories: 

- PROFIBUS-DP, PROFIBUS PA, PROFINET IO, SIMATIC300, SIMATIC400, 

 SIMATIC PC Based Control, and SIMATIC PC Station. 

Insert the 'Mounting Channel’ with a double click ( → SIMATIC 300 → RACK 300  

→ Mounting Channel). 

 

 
 

 

Then, a configuration table is displayed automatically for setting up Rack 0. 

 

 



           Automation and Drives - SCE 

   

 

T I A  Training Document Page 13 of 32 Module 
E06 
Status: 02/2008      PROFINET/PROFIBUS DP with CPU 315F-2 PN/DP/ IE/PB Link and DP Slave ET 
200S 

Preface                                     Notes                                     StartUp 

 

9.  From the HW catalog you can now select all modules that are inserted in your actual rack and 

insert them in the configuration table.  To this end, click on the name of the respective module, 

hold the mouse key and drag it into a line in the configuration table. 

We start with the power supply unit 'PS 307 2A’. (→ SIMATIC 300 →  PS-300 → PS 307 2A) 

 

 
 

 

 

Note: If your hardware differs from the hardware shown here, simply select the corresponding 

modules in the catalog and insert them in your rack. 

The order numbers of the individual modules that are also inscribed on the components are 

displayed in the footer of the catalog.
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10. Now we drag the ’CPU 315F-2 PN/DP’ to the second slot. The order number and the version of 

the CPU are indicated on the front of the CPU. (→ SIMATIC 300 →  CPU-300 → CPU 315F-2 

PN/DP → 6ES7 315-2FH10-0AB0 → V2.3) 

 

 
 

11. When entering the CPU, the window below is displayed.  In it, you have to assign an ’IP 

Address’ to the CPU 315F-2 PN/DP, specify the ’Subnet screen form’ and select the 

’Ethernet’ already provided. As an option, you can also select a ’Router Address’ for 

network-overreaching communication. Confirm your input with ’OK’ (→ IP Address: 

192.168.1.10 → Subnet screen form: 255.255.255.0 → Ethernet(1) → Use router →  

Address: 192.168.1.1 → OK) 
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Notes about networking at the Ethernet (additional information is provided in Appendix V of 

the training document): 

 

MAC Address: 

The MAC address consists of a permanent and a variable part.  The permanent part ("Basis MAC 

Address") indicates the manufacturer (Siemens, 3COM, ...). The variable part of the MAC address 

distinguishes among the different Ethernet stations, and should be assigned globally unique. Each 

module is imprinted with a MAC address specified by the factory. 

 

Value Range for the IP Address: 

The IP address consists of 4 decimal numbers ranging from 0 to 255, separated by a period.  For 

example: 141.80.0.16 

 

Value range for the subnet screen form: 

This screen form is used to indicate whether a station or its IP address is part of the local subnet, or 
accessible only by using a router. 
The subnet screen form consists of 4 decimal numbers ranging from 0 to 255, separated by a period; 

for example, 255.255.0.0 

In their binary representation, the 4 decimal numbers have to contain from the left a series of 

contiguous values "1" and from the right a series of contiguous values "0". 

The values "1" determine the area of the IP address for the network number. The values "0" specify 

the area of the IP address for the station address. 

Example:  

Correct values: 255.255.0.0 decimal = 1111 1111.1111 1111.0000 0000.0000 0000 binary 

    255.255.128.0 decimal = 1111 1111.1111 1111.1000 0000.0000 0000 binary 

    255.254.0.0 decimal = 1111 1111.1111 1110.0000 0000.0000.0000 binary 

Incorrect value: 255.255.1.0 decimal = 1111 1111.1111 1111.0000 0001.0000 0000 binary 

 

Value range for the gateway address (Router): 

The address consists of 4 decimal numbers ranging from 0 to 255, separated by a period; for 

example, 141.80.0.1.  

 

Relationship of IP addresses, router address, and subnet screen form: 

The IP address and the gate way address are to differ only at positions where a "0" occurs in the 

subnet screen form. 

Example: 

You entered the following: for the subnet screen form 255.255.255.0; for the IP address 141.30.0.5 

and as router address  141.30.128.1.  

The IP address and the gateway address must differ only regarding the 4th decimal number. 

However, in the example, already the 3rd position differs.  

In the example, you have to make the following change: 

- the subnet screen form to: 255.255.0.0 or 

- the IP address to: 141.30.128.5 or 

- the gateway address to: 141.30.0.1 
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12. After you have accepted the network settings, a bar is displayed to the right of the CPU315F-2 

PN/DP -the ’PROFINET IO System’- where you can arrange PROFINET IO devices. This is done 

by clicking on the desired module (here ’IE/PB Link PN IO’.) in the hardware catalog in the path 

’PROFINET IO’ and dragging it to the ’PROFINET IO System’. The order number and the version 

are provided on the front of the IE/PB Link PN IO (→ PROFINET IO → I/O → Gateway → IE/PB 

Link PN IO → 6GK1 411-5AB00 → V1.0 ). 

 
 

13. When entering the IE/PB Link PN IO, the following window is displayed where you have to assign 

a ’PROFIBUS Address’ to the IE/PB Link PN IO, and select the ’PROFIBUS’ network provided. 

Then confirm your input with ’OK’ (→ PROFIBUS →  Address: 2 → OK) 
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14. Now, using the right mouse key, click on the ’IE/PB Link PN IO’ and open its 'Object 

attributes’. ( → IE/PB Link PN IO → Object attributes) 

 

 
 

15. To each IO device, a ’device name’ that is unique within the PROFINET IO system and an IP 

address has to be assigned on the ’Ethernet’. ( → Device name: IE/PB Link → Ethernet) 
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16. After the ’IP Address’ is assigned, it has to be accepted with ’OK’.  

 (→ IP Address: 192.168.1.11 → OK → OK) 
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17. After you have accepted the network settings, a bar appears to the right of the IE/PB Link PN IO - 

the ’PROFIBUS DP Master System’-  where you can arrange PROFIBUS slaves. This is done by 

clicking on the desired module (here ’ET200S’ with the ’IM151-1 HF) in the hardware catalog in 

the path ’PROFIBUS DP’ and dragging it to the ’PROFINET DP Master System’. The order 

number is provided on the front of the IM151-1 HF. (→ PROFIBUS DP → ET200S → IM151-1 

HF). 

 

 
 

18. When entering the slave, the following window is displayed.  Here, you have to assign a 

PROFIBUS address to the slave.  It has to be identical with the address that you set on the 8 

switches at the interface module IM151-1 HF. ( → 3 → OK ) 
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19. From the hardware catalog, you now can select all additional modules that are present in your 

actual ET200S and insert them in the configuration table. To this end, click on the name of the 

respective module, hold the mouse key und drag it to a line in the configuration table. Let’s start 

with the power module ’PM-E DC24V...4 key8V/AC24...230V’ by dragging it to Slot 1. ( → 

PROFIBUS DP → ET200S → IM151-1 HF → PM → PM-E DC24V...48V/AC24...230V) 
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20. Next, we drag the digital input module ’2DI DC24V ST’ to the second slot. The order number and 

the version are provided in the module. (→ PROFIBUS DP → ET200S → IM151-1 HF → DI → 

2DI DC24V ST) 

  

 

21. Now, we drag the digital output module ’4 DO DC24V/0,5A ST’ to the 3rd slot. The order number 

and the version are provided on the module. (→ PROFIBUS DP → ET200S → IM151-1 HF → DO 

→ 4 DO DC24V/0.5A ST) 
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22. Now we can change the addresses of the inputs and outputs in the ET200S. This is done by 

double clicking on the corresponding input/output modules in the ET200S and setting them in the 

tab ’Addresses’. These addresses should be noted down in each case. Addresses are assigned 

automatically in the sequence in which the modules were entered. ( → 4DO DC24V/0.5A ST → 

Addresses → OK) 

 

 

 

23. By clicking on ' ’ the cofiguration table will now be saved and converted (→ ) 
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24. Next, we assign an IP address to the IO device after it was highlighted. (→IE/PB Link → Target 

system → Ethernet → Edit Ethernet station) 

 

 
 

Note: A precondition for this is that the PG/PC interface is set to TCP/IP and the PC’s network card is 

configured correctly. For example: IP address 192.168.1.99, subnetwork 255.255.255.0 and router 

address 192.168.1.1. (Refer to Module E02!) 

 

 

Note: make sure your programming device is connected to the IE/PB link by means of the Ethernet! 
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25. In the dialog box below, we will now look for all stations that are accessible online by means of the 

Ethernet. (→ Search) 

 
 

26. Shortly after ’Start’(ing) the search, all stations available in the network are displayed with their  

MAC addresses.  If IP addresses have been assigned, they are displayed also. Here, select the 

’IE/PB Link’  (→ Start → IE/PB Link → OK) 
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27. In the following window, you can now assign the ’IP Address’ to your device, and specify the 

’Subnet screen form’. As an option, a ’Router Address’ can be selected for network 

overreaching communication. After you assigned the IP configuration <<’IP-Konfiguration 

zuweisen’>>,  confirm the indication with ’OK’, and close <<’Schließen’>> the dialog. (→ IP Address: 

192.168.1.11 → subnet form screen: 255.255.255.0 → Use router →  Address: 192.168.1.1 →

Assign IP configuration’ → OK → Close).  
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28. Now, the IO device has to be assigned the device name <<’Gerätename vergeben’>> after it was 

highlighted. (→IE/PB Link → Target system → Ethernet → Assign device name) 

 
 

Note: A precondition for this is that the PG/PC interface is set to TCP/IP and the PC’s network card is 

configured correctly. For example, IP address 192.168.1.99, subnetwork 255.255.255.0 and router 

address 192.168.1.1. (Refer to Module E02!) 

 

 

Note: Make sure that your programming device is connected to the IE/PB link by means of the 

Ethernet! 
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29. Now we have to select the ’IE/PB Link’ in order to assign the name <<’Name zuweisen’>>. (→IE/PB 

Link → Assign name) 

 

 

 

Note:  If several IO devices are on the network, the device can be identified by using the  

 imprinted MAC address. 

 

 

30. The new device name is displayed in the area ‘Available devices’ ’Vorhandene Geräte’. ’Close’ the 

dialog. ( → Close) 
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31. The configuration table can now be loaded to the PLC by clicking on ' ’. The operating mode 

switch on the CPU should be on STOP! ( → ) 

 

 

 

 

Note: Make sure that your programming device is connected to the CPU by means of the Ethernet! 
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32. The CPU 315F-2 PN/DP is confirmed as the target module for the loading process. (→ OK) 

 

 
 

33. In the dialog box below, you can have the connected devices in the network displayed 

<<’Anzeigen’>> . (→ Display) 
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34. We now select the CPU’s MAC address on the Ethernet. If you are connected to only one CPU, 

accept with ’OK’. (→ OK) 

 

 
 

 

Note:  If several IO controllers are on the network, the device can be identified with the  

 inscribed MAC address. 

 

 

 

35. Next, the IO controller has to be assigned the correct IP address if it is not yet set correctly. 

Confirm this in the following dialog box with 'Yes’. (→ Yes) 
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36. After the hardware configuration is loaded, we can start with generating the program. In the 

’SIMATIC Manager’, open the block ’OB1’ with a double click. ( → OB1) 

 

 
 

37. Select the programming language FBD ’Erstellsprache FUP’ and accept with ’OK’ (→ FBD →OK) 
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38. With ‘Program LAD, STL, FBD S7  blocks’ ‘KOP, AWL, FUP- S7 Bausteine programmieren’,  you now 

have an editor that allows you to create your STEP7 program correspondingly. To this end, the 

organization block OB1 has already been opened with the first network. You have to highlight the 

first network to establish your initial operations. Now you can write your first STEP7 program. In 

STEP 7, individual programs are usually divided into networks. Clicking on the network symbol  

' ’ opens a new network. 

The STEP7 program that is to be tested can now be loaded to the PLC. 

In our case, it is only OB1. Save the OB ' ’ and click on Load ’ ’. The CPU’s key switch 

should be in the Stop position! ( → ‚ ’  → ) 

 

 
 

 

39. Switching the operating mode switch to RUN starts the program, and after clicking on the ’ ’ 

symbol for monitoring, the program can be observed in ’OB1’.  

(→ ‚ ’) 

 

 

Note: Make sure that the CPU is connected with the IE/PB link by means of the Ethernet, and the 

IE/PB link with the ET200S by means of the PROFIBUS! 

 

 

 

 


